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1 Introduction 
SimpleSend is an advanced file transfer program capable of performing 
secure, automated bulk transfers of data via FTP or e-mail, and is designed 
to work seamlessly with the rest of the SimpleIndex Imaging Suite. 
 
SimpleSend works from a windows GUI, the command line, and can be run 
as a service.  The command line interface allows for automation of uploads 
via the scheduled tasks, the SimpleIndex Post-Process feature or by 
launching it from a custom application.  Running SimpleSend as a service 
allows scheduling projects and transfers without having to have an 
interactive desktop session open. 
 
SimpleSend lets you define complex file sets for upload.  These file sets 
can contain any type of file, whole folders or folder trees.  File sets can also 
be defined via the command line, or by importing a SimpleIndex IDX file.  
The IDX file has a simple comma separated format containing index values 
and file paths.  These are generated automatically by SimpleIndex or they 
can be exported from Excel, Access or a custom application. 
 
If the IDX file contains an e-mail address field, SimpleSend can be used to 
automatically route the files listed to the e-mail address associated with 
each file.  When this feature is used with SimpleIndex and 
SimpleCoversheet, the result is a fully-automated digital mailroom solution. 
 
All of the file selection and transfer settings can be saved to a SimpleSend 
Configuration File (*.ssf).  This can be launched from an icon by double-
clicking.  SSF files can be passed via the command line, making it easy for 
developers to define complex uploading and e-mailing routines and launch 
them with a single line of code. 
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2 Freeware Features & Licensing 
2.1 Compare Free & Full Features 
When SimpleSend is first installed, it is automatically set to run in Freeware 
Mode, with only certain features enabled. The differences between the 
freeware and the full version of SimpleSend are below: 
 

Features Free Full 
Batch upload files to FTP  

  

Batch email files to recipients  
  

Batch copy files to network folders  
  

Support for secure FTP (SSL)  
  

   Synchronize files between folders or FTP sites  
  

Load file/data lists from delimited text files (CSV, TSV, etc.)  
  

   Load file/data lists from any database  
  

Merge data into email header and body  
  

Split large files into smaller files when emailing  
  

Perform multiple file transfers or email operations in one batch  
  

Run single jobs interactively in the application window  
  

Run jobs from a command line    

Schedule jobs to run automatically as a windows service    

 
If you want to use the full feature set, you can try the demo for 30 days or 
purchase the software to activate the full version with a serial number. 
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2.2 Running in Free & Demo Modes 

 
 

Click the Demo Full Version button to launch SimpleSend in demo mode. 
During the 30 day trial this option will enable all features of the full version. 
 
Click Use Free Version to launch SimpleSend in free mode. This option 
never expires. 

2.3 Activating the License 
 
To activate the full version of SimpleSend, enter your serial number in the 
box and click Activate. If you are connected to the Internet and no firewall is 
blocking it, SimpleSend will connect to the activation server and register 
automatically.  
 
If connectivity problems prevent communication with the activation server, 
you may activate offline by clicking the Offline Activation button and 
following the on-screen instructions. 
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3 SimpleSend 
SimpleSend provides an interface to automatically send images scanned 
with SimpleIndex, or any other type of file, to a central server via FTP.  It is 
also possible to automatically route documents via E-mail.  SimpleSend 
projects allow for the transfer of multiple sets of files to multiple destinations 
using different protocols within the same configuration file.  Command line 
functionality allows for the creation of these projects on the fly from the 
command line; allowing one to automatically create and transfer file sets 
once processing has been completed by your capture software.  
Alternatively, you may schedule transfers to occur on a daily or weekly 
basis during non-peak hours, reducing traffic and more efficiently utilizing 
your company’s bandwidth. 
 

3.1 SimpleSend Projects 
 
SimpleSend projects are composed of components which encapsulate sets 
of files as well as the different types of file transfers.  Existing projects can 
be opened, and new projects can be created from the File menu.  Different 
aspects of the project may be changed by accessing the Project menu.   
 

 
 
Under the Project menu you may add the various types of components to 
the project, import components from existing projects, run the project, and 
access the project’s options.  As you add components to the project you 
will see them appear in the leftmost pane of program window. 
From the Component menu one can remove previously added 
components, rename the currently selected component, and access the 
advanced options associated with each component. 
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3.1.1 The File Set Component 
The File Set Component allows one to create a file set by selecting files 
and directories according to wildcard filters.  First select the drive and 
directory that your files are in.  This will populate the second list with the 
files in that directory.  Then select the appropriate files and click Add 
File(s).  This will add the selected files to the file set according to the 
wildcard that is specified in the filter.  This is illustrated in the figure below 
where only TIFF files that have a ‘1’ in the file name are added. 
 

 
 
It also possible to have SimpleSend add files automatically before 
transferring.  This is accomplished with the Add Directory button.  In the 
example above, all TIFF files in the C:\Program 
Files\SimpleIndex\Configs\Invoice Processing\Output directory will be 
added before transfer, as well as all the TIFF files in all its subdirectories 
because the ‘Include subfolders’ option is clicked.  The recursion is 
denoted by a ‘/R’ in the selected files list. 
 

3.1.2 The FTP Transfer Component 
The FTP Transfer Component allows for the transfer of multiple file sets to 
multiple destinations on a remote server.  Begin by entering the settings for 
the remote FTP server.  Once you click Connect and you have correctly 
specified the settings, the program will connect to the FTP server and 
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retrieve the directories.  Note that you do not need to connect to the FTP 
server if you plan on manually typing in the destination directories’ names.  
The status and operational messages from the FTP server are displayed in 
the lower left corner of the window.  The current directory is displayed in a 
box above the directory listing and can be changed by browsing the 
directories in the listing or by manually typing the directory name into the 
box.  Once the desired directory has been browsed to or entered, click Add 
Directory to add the directory as a selected destination on the FTP server.  
Next you will want to select file sets to be transferred to your selected 
destination directory.  To do this, first select the directory that you have just 
added.  Then choose an existing file set from the drop down box and click 
Add File Set.  In the following figure, File Set1 is set to be transferred to the 
/public_ftp/incoming directory on ftp.scanstore.com. 
 

 
 

3.1.3 The Email Transfer Component 
The Email Transfer Component allows for the sending of file sets via email 
attachments.  Begin by choosing how you intend to have your emails sent.  
MAPI is for sending email from your desktop via your mail client.  SMTP is 
for connecting directly to your server and should be used if you intend to 
run the project as a service.  Then select an existing file set from the drop 
down box and click Add File Set to add the file set to the current email 
transfer.  Once you have added file sets, select them in the list to view and 
set the email message information associated with them. 



SimpleSend Documentation 

- 10 - 

In the figure below, all files in FileSet1 have been set to be emailed to 
‘someone@email.com’ with the corresponding subject and body. 
 

 
 
You can add multiple attachments per email by setting a limit of greater 
than 1 on the number files, or by setting a size limit that will include multiple 
files.  For instance, if you set the limit at 1024, and you had a file set 
composed of a number of 100KB files then 10 of those files would be 
attached to each email sent.  
 

3.1.4 The Automailer Component 
The automailer component is used to send emails and files according to 
records in a database.  The component will attempt to send an email for 
each record in the table that you specify.  It is assumed that at least one 
entry in the table will be the email address, or that you want all emails to be 
sent to the same address.  Before sending an email, replacements are 
made on the text of the email according to the column names of the 
selected table.  So, assuming the column names in the database are Email, 
FullName, FileName and Subject.  You would most likely have %Email% in 
the To field of the email message information, %Subject% as the Subject, 
and %FileName% in the attachment field.  Alternatively, if you wanted to 
send one file to multiple email addresses you can put the name of that file 
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in the attachment field.  You could also use %FullName% to begin the text 
of your email.  This is illustrated in the figure below. 
 

 
 
In addition to just normal %Replacements%, it is also possible to format 
dates and time.  If one of the columns in your database is of the date or 
time type, then you can format it by using a pipe(“|”) separator and then 
some formatting code.  For example, say the column’s name is SendDate 
and you wanted to only use the date, but not the time, you could use the 
following text to be replaced %SendDate|MM/dd/yyyy%.  See Appendix A – 
Date and Time Formatting for available date and time formatting 
strings/characters. 
 

3.1.5 File Synchronization Component 
 
This component allows you to synchronize files between the source in a file 
set and a specified destination directory.  Just browse to the destination 
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folder, add it, select it, and then choose the file set that should be 
synchronized to it.  Currently, newer files will overwrite old ones, and any 
files existing in the source and not in the destination, or vice-versa, will be 
copied as well.  In the following figure, the files in C:\Program 
Files\SimpleIndex\Configs\Output are set to be synchronized with the 
folder(s) specified in File Set1. 
 
 
 

 
 

3.2 Project and Component Options 
The general options for the project can be accessed via the Project menu.  
The advanced options for each component can also be accessed in this 
manner.  The menu option labeled ‘Advanced Options’ in the Component 
menu will open the options dialog with the tab for the current component 
selected.  The only general options involve the log file associated with the 
current project.  On this options page you may specify the name of the log 
file, as well as whether or not the log file should be created new each time, 
or just appended with each new transfer. 
 

3.2.1 File Set Advanced Options 
 
For File Set Components, you may specify a SimpleIndex Index file that 
images will be added from.  You may also specify multiple index files with 
wild cards such as C:\Program Files\SimpleIndex\Log\*.idx.  If the path 
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names in the index file are relative paths, you may also specify the prefix to 
be used with those relative paths.  Images, if desired, can be moved or 
removed after all transfers have been completed.  By default, system and 
hidden files are ignored, however, you may also choose to include them 
when SimpleSend is searching for files to include in the file set.  You may 
also enable stop file functionality for the file set.  This is used when running 
SimpleSend in conjunction with SimpleIndex.  If enabled, SimpleSend will 
place a file named stopfile.txt in the directories it is processing so that 
SimpleIndex will not attempt to access the same files.  Enabling this 
options also causes SimpleSend to check for a stop file in directories used 
by the file set, and if one exists, it will wait until it is no longer there before 
processing. 
 

 
 

3.2.2 FTP Transfer Advanced Options 
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Options here allow you to specify whether or not to automatically reconnect 
if a connection is dropped during transfer, how many times to attempt to 
reconnect, and how long to wait between attempts.  The default is to retry 
the connection a total of 5 times, after a 5 second wait.  This feature is 
useful if you are scheduling transfers to occur unattended. 
 
By default the FTP Transfer component will upload files even if they exist 
on the remote server, overwriting them, and does no downloading.  With 
the Synchronization Options you can setup your project so that 
SimpleSend will synchronize the files in your file set with the files in the 
remote directory on the FTP server.  You may also choose to only 
overwrite remote files if the local file is newer, or download or remove 
remote files that do not exist locally.  For a two way synchronization, enable 
the 1st, 3rd, and 4th options.  For synchronizing the remote directory with the 
local directory, enable only the 2nd option. 
 
You may also enable stop file functionality for the FTP Transfer component.  
This should be used when running SimpleSend in conjunction with 
SimpleIndex in a scenario where SimpleIndex is set to process the files the 
destination directory of the upload.  If enabled, SimpleSend will upload a 
file named stopfile.txt in the remote directories it processes so that 
SimpleIndex will not attempt to access the same files.  Enabling this 
options also causes SimpleSend to check for a stop file in the remote 
destination directories, and if one exists, it will wait until it is no longer there 
before uploading the files. 
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3.2.3 Email Transfer Advanced Options 
 
For Email Transfer Components, you may specify a SimpleIndex Index file 
that will be used to match image names, and populate the message 
information according to the matched information.  For this to work 
properly, a file set containing the image names specified in the index file 
must be added to the email transfer.  The fields in the index file can be 
accessed when setting the email message information by using %Field#% 
where Field# is a 1,2,3,etc… that corresponds to a field in the index file.  
The following figure shows an example index file. 
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Once specified, the index file values can be accessed as follows: 
 

 
 
Where %1% means the first field, %2% the second, and so on… 
 
If you are using the MAPI option for sending your emails, you can also 
have SimpleSend prepare the emails to be sent rather than automatically 
sending them. 
 

3.2.4 Automailer Advanced Options 
 
Just like the Email Transfer component, the Automailer component can 
prepare but not send your emails if you are using MAPI and not SMTP. 
 
Sometimes it is necessary to send emails to an address only once from the 
same table that is updated with new addresses.  In this case you can setup 
the table with a “sent” field that can be checked and updated when an 
email is sent. 
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Make sure your database connection is setup before trying to enable the 
flag field options.  In the case above, the component is connected to a 
database with a table that has a column named FLAGFIELD.  This will 
cause SimpleSend to only send emails for records where FLAGFIELD 
column’s value is False, and after sending the email, will set the column’s 
value to true.  This way, the next time project is run, an email will not be 
sent for that same record, and new records can be added where the flag 
field’s default value is false that will be sent. 
 
The last option is the grouping option, which allows you to only send one 
email for multiple rows containing the same unique email address, or other 
value.  Assume we want to notify a person of all the different items they 
may have ordered and we have a table that has a record for each item 
ordered; the email address would be the same for each item.  Something 
similar to the table below: 
 

EMAIL ORDER_NUMBER ITEM_NUMBER ITEM_DESC QTY 

tom@yahoo.com 34556 123-ABC 
Large Volume 
Scanner 1 

tom@yahoo.com 34556 3ER4-6 Part #1 for Scanner 2 
tom@yahoo.com 34556 3ER4-7 Part #2 for Scanner 5 
jerry@gmail.com 64564 SS-SIMPLESEND SimpleSend 3.0 1 

jerry@gmail.com 64564 
SS-
SIMPLECOVERSHEET SimpleCoversheet 3.0 1 
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If we choose to only send emails for the unique values in column EMAIL 
there will only be two emails sent; one to tom@yahoo.com, and one to 
jerry@gmail.com.  It is possible to use %COLUMN_NAME% strings to 
account for all the different information in each record.  In order to 
accomplish this, you need to put the text you want repeated for each record 
containing the unique value inside {brackets}.  Note that for 
%COLUMN_NAME% replacements that appear outside brackets, the value 
from the first record will be used.  For example: 
 

 
 
With the above configuration, having the unique value column set to 
EMAIL, The first email that would be sent would look something like this: 
 
 To:  tom@yahoo.com 
 From:  orders@simpleindex.com 
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 Subject: Order Number: 34556 

 
 Simple Software Customer 
 

You ordered the following parts which are in separate records in our 
database: 

 
Quantity - Item No. - Description 

 1 – 123-ABC – Large Volume Scanner 
 2 – 3ER4-6 – Part #1 for Scanner 
 3 – 3ER4-7 – Part #2 for Scanner 
 

-Simple Software Team 
 

3.2.5 File Synchronization Advanced Options 
 
If you enabled stop file functionality for a file synchronization component, 
SimpleSend will place stop files in the directories it is synchronizing to.  
This should be used when SimpleIndex is processing files from the 
directories that the component is copying files to.  The option will also 
cause SimpleSend to look for a stop file in the destination directories it is 
set to copy to, and if it finds one, it will wait until it is no longer there before 
copying any files. 
 

3.3 Tools 
From the Tools menu you may schedule the current project to run at a 
certain time via the scheduled tasks or as a service.  You may also load 
match and merge index information for email components or add files to a 
file set from index information.  Also, if a file set or email transfer has index 
information associated with it, you may view it with notepad from the Tools 
menu. 
 

3.3.1 Service Options 
 
On the Service Options dialog you can start and stop the SimpleSend 
Service, as well as remove and install it.  You must have administrative 
options on the account you are configuring the service.  For Windows 7 and 
Vista, be sure to run the program as administrator.  Be aware that any time 
you make changes to a project you must restart the service for the changes 
to take effect.  In order to have a project run by the SimpleSend service, 
first click the Add Project from File button to add the project to the list.  
Then select the project in the list to display its run options.  You can specify 
what time of the day the project should run, which days of the week, or 
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alternatively have the project run multiple times a day.  You may add 
multiple projects to the list, and have different run schedules for each one.  
When finished, click Save Changes which will restart the service with the 
changes you have made. 
 

 
 

3.3.2 Default Mailing Options 
 
This setup is similar to the configuration options on the Email Transfer and 
Automailer components.  Setting these options causes every newly created 
Email Transfer and Automailer component to inherit these settings.  These 
options are also helpful when using SimpleSend via the command line.  
Since the mailing options cannot be set via the command line you will need 
to set them here if you intend to run a SimpleSend project via the command 
line that contains an Automailer or Email Transfer component. 
 



SimpleSend Documentation 

- 21 - 

 
 
 
 

3.4 Command Line 
Almost everything that can be accessed or configured within SimpleSend 
can also be specified on the command line.  Usage is as follows: 
 
     SimpleSend.exe [file name] 
     SimpleSend.exe [/hide] [/run] [/Component Type:[options...]]  
[/Component flags:[Component flag options]] 
     SimpleSend.exe [file name] [/hide] [/run] [/Component Type:[options...]]  
[/Component flags:[Component flag options]] 
 
     Note: 
 

To include a space use quotations to surround the value, and all 
switches are case sensitive.  Also, using “/Component Type” switches 
after also specifying a file name will alter the named components in 
the existing file or add new ones if they don’t already exist. 

 
     Options: 
 

/run  immediately runs the project once it is open 
/hide  hides the interface when using the /run option 
/log:C:\New\Log\FileLocation.log 

change the default log file name 
    /installservice:”C:\Path to config\file.ssf” 
   This will install the simplesend service and run the   
   specified configuration file as a service 
 /startservice 
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   Starts the service running 
 
     When adding components, anything that is indented must be 
     specified on the command line in the order that it appears here. 
     Anything in [brackets] is optional. 
     Adding Components: 
 
     File Set 

/FS:Name 
/dir:C:\folder\*filter*.tif [/R] 

      /file:C:\folder\file.tif 
     /idx:C:\folder\indexFile.idx,C:\pathPrefix\ 
  /move:C:\folder\to\move\to 
 
     FTP Transfer 

/FTP:userName:Password@servername:port 
 [/passive] 

/dir:/folder/on/remote/host 
/fs:FileSet_to_be_Transferred 

 
     Email Transfer 

/EMAIL:Name[:C:\MatchNMerge\index\file.idx] 
/fs:FileSet_to_be_Transferred,To,Subject,Body[,Limit[KB]] 
/nosend 

 
Examples: 
 
/FS:IndexImages /idx:”C:\folder with spaces\theIndexFile.idx”,”C:\Images Path Prefix\” /EMAIL:”C:\folder 
with spaces\theIndexFile.idx” /fs:IndexImages,%1%,”Subject: %2%”,”Body: %3%” /nosend 
 
This command line will create a file set component with the files that are 
contained in the index file theIndexFile.idx.  An email transfer component is 
then created that matches and merges the information in that index file in 
order to use field 1 as the recipient of the email, field 2 as the subject, and 
field 3 as body of the email.  The /nosend switch just prepares the email to 
be sent instead of sending it. 
 
/FS:DirectoryOfImages /dir:”C:\path\to\images\*1.tif” /R /EMAIL 
/fs:DirectoryOfImages,recipient@address.com,”Requested Images”,,1024KB 
 
This command line will create a file set component composed of all tiff files 
whose names end in “1” that are in the subdirectories(due to the /R switch) 
of the directory “C:\path\to\images,” and in the “C:\path\to\images” directory 
itself.  That file set will the be emailed to recipient@address.com in emails 

mailto:recipient@address.com�
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with attachments that will not exceed the size of 1024KB.  Now suppose 
you wanted to send 3 images per email no matter the size of the files, just 
use “3” in place of “1024KB.” 
 
 /FS:SingleFile /file:”C:\path to file\filename.extension” /FS:SingleFile2 
/file:”C:\path\to\second\file\filename.tif” /FTP:user_name:the_password@servername.com:21 
/dir:/destination1/folder /fs:SingleFile /dir:/destination/folder2 /fs:SingleFile2 /run 
 
This command line creates two file set components with one file each.  
Then each of these files is sent to servername.com via FTP on port 21 
using “user_name” as the user name and “the_password” as the password.  
The file set named SingleFile is sent to the directory named 
“/destination1/folder,” and the file set named SingleFile2 is sent to the 
directory name “/destination/folder2.”  The transfer will be performed as 
soon as the command line is run due to the /run switch. 
 

4 Contacting Simple Software 
 
SimpleIndex Website: http://www.simpleindex.com 
 
Mailing Address: 
 PO Box 548 
 Knoxville, TN  37901-0548 
 
Physical Address: 
 500 West Summit Hill Drive, Suite 302 
 Knoxville, TN  37902 
 
Sales/General E-Mail: info@SimpleIndex.com  
 
Tech Support E-Mail: support@SimpleIndex.com  
 
Phone Number: 877-355-4141 
 
 
 
 
 
 
 
 
 

http://www.simpleindex.com/�
mailto:info@SimpleIndex.com�
mailto:support@SimpleIndex.com�
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5 Appendix A – Date and Time Formatting 
 
 
Format 
specifier 

Description Examples 

"d" The day of the month, 
from 1 through 31. 

6/1/2009 1:45:30 PM -> 1 

  6/15/2009 1:45:30 PM -> 15 

"dd" The day of the month, 
from 01 through 31. 

6/1/2009 1:45:30 PM -> 01 

  6/15/2009 1:45:30 PM -> 15 

"ddd" The abbreviated name of 
the day of the week. 

6/15/2009 1:45:30 PM -> Mon (en-US) 

  6/15/2009 1:45:30 PM -> Пн (ru-RU) 
  6/15/2009 1:45:30 PM -> lun. (fr-FR) 

"dddd" The full name of the day 
of the week. 

6/15/2009 1:45:30 PM -> Monday (en-US) 

"f" The tenths of a second in 
a date and time value. 

6/15/2009 13:45:30.617 -> 6 

  6/15/2009 13:45:30.050 -> 0 

"ff" The hundredths of a 
second in a date and time 
value. 

6/15/2009 13:45:30.617 -> 61 

    
  6/15/2009 13:45:30.005 -> 00 

"fff" The milliseconds in a date 
and time value. 

6/15/2009 13:45:30.617 -> 617 

    
  6/15/2009 13:45:30.0005 -> 000 

"ffff" The ten thousandths of a 
second in a date and time 
value. 

6/15/2009 13:45:30.6175 -> 6175 

    
  6/15/2009 13:45:30.00005 -> 0000 

"fffff" The hundred thousandths 
of a second in a date and 
time value. 

6/15/2009 13:45:30.61754 -> 61754 
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  6/15/2009 13:45:30.000005 -> 00000 

"ffffff" The millionths of a second 
in a date and time value. 

6/15/2009 13:45:30.617542 -> 617542 

    
  6/15/2009 13:45:30.0000005 -> 000000 

"fffffff" The ten millionths of a 
second in a date and time 
value. 

6/15/2009 13:45:30.6175425 -> 6175425 

    
  6/15/2009 13:45:30.0001150 -> 0001150 

"F" If non-zero, the tenths of a 
second in a date and time 
value. 

6/15/2009 13:45:30.617 -> 6 

    
  6/15/2009 13:45:30.050 -> (no output) 

"FF" If non-zero, the 
hundredths of a second in 
a date and time value. 

6/15/2009 13:45:30.617 -> 61 

    
  6/15/2009 13:45:30.005 -> (no output) 

"FFF" If non-zero, the 
milliseconds in a date and 
time value. 

6/15/2009 13:45:30.617 -> 617 

    
  6/15/2009 13:45:30.0005 -> (no output) 

"FFFF" If non-zero, the ten 
thousandths of a second 
in a date and time value. 

6/1/2009 13:45:30.5275 -> 5275 

    
  6/15/2009 13:45:30.00005 -> (no output) 

"FFFFF" If non-zero, the hundred 
thousandths of a second 
in a date and time value. 

6/15/2009 13:45:30.61754 -> 61754 

    
  6/15/2009 13:45:30.000005 -> (no output) 

"FFFFFF" If non-zero, the millionths 
of a second in a date and 
time value. 

6/15/2009 13:45:30.617542 -> 617542 

    
  6/15/2009 13:45:30.0000005 -> (no output) 
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"FFFFFFF" If non-zero, the ten 
millionths of a second in a 
date and time value. 

6/15/2009 13:45:30.6175425 -> 6175425 

    
  6/15/2009 13:45:30.0001150 -> 000115 

"g", "gg" The period or era. 6/15/2009 1:45:30 PM -> A.D. 
  
  

"h" The hour, using a 12-hour 
clock from 1 to 12. 

6/15/2009 1:45:30 AM -> 1 

    
  6/15/2009 1:45:30 PM -> 1 

"hh" The hour, using a 12-hour 
clock from 01 to 12. 

6/15/2009 1:45:30 AM -> 01 

    
  6/15/2009 1:45:30 PM -> 01 

"H" The hour, using a 24-hour 
clock from 0 to 23. 

6/15/2009 1:45:30 AM -> 1 

    
  6/15/2009 1:45:30 PM -> 13 

"HH" The hour, using a 24-hour 
clock from 00 to 23. 

6/15/2009 1:45:30 AM -> 01 

    
  6/15/2009 1:45:30 PM -> 13 

"m" The minute, from 0 
through 59. 

6/15/2009 1:09:30 AM -> 9 

    
  6/15/2009 1:09:30 PM -> 9 

"mm" The minute, from 00 
through 59. 

6/15/2009 1:09:30 AM -> 09 

    
  6/15/2009 1:09:30 PM -> 09 

"M" The month, from 1 
through 12. 

6/15/2009 1:45:30 PM -> 6 

  
  

"MM" The month, from 01 
through 12. 

6/15/2009 1:45:30 PM -> 06 

  
  



SimpleSend Documentation 

- 27 - 

"MMM" The abbreviated name of 
the month. 

6/15/2009 1:45:30 PM -> Jun (en-US) 

    
  6/15/2009 1:45:30 PM -> juin (fr-FR) 
    
  6/15/2009 1:45:30 PM -> Jun (zu-ZA) 

"MMMM" The full name of the 
month. 

6/15/2009 1:45:30 PM -> June (en-US) 

    
  6/15/2009 1:45:30 PM -> juni (da-DK) 
    
  6/15/2009 1:45:30 PM -> uJuni (zu-ZA) 

"s" The second, from 0 
through 59. 

6/15/2009 1:45:09 PM -> 9 

  
  

"ss" The second, from 00 
through 59. 

6/15/2009 1:45:09 PM -> 09 

  
  

"t" The first character of the 
AM/PM designator. 

6/15/2009 1:45:30 PM -> P (en-US) 

    
  6/15/2009 1:45:30 PM -> 午 (ja-JP) 
    
  6/15/2009 1:45:30 PM -> (fr-FR) 

"tt" The AM/PM designator. 6/15/2009 1:45:30 PM -> PM (en-US) 
    
  6/15/2009 1:45:30 PM -> 午後 (ja-JP) 
    
  6/15/2009 1:45:30 PM -> (fr-FR) 

"y" The year, from 0 to 99. 1/1/0001 12:00:00 AM -> 1 
    
  1/1/0900 12:00:00 AM -> 0 
    
  1/1/1900 12:00:00 AM -> 0 
    
  6/15/2009 1:45:30 PM -> 9 

"yy" The year, from 00 to 99. 1/1/0001 12:00:00 AM -> 01 
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  1/1/0900 12:00:00 AM -> 00 
    
  1/1/1900 12:00:00 AM -> 00 
    
  6/15/2009 1:45:30 PM -> 09 

"yyy" The year, with a minimum 
of three digits. 

1/1/0001 12:00:00 AM -> 001 

    
  1/1/0900 12:00:00 AM -> 900 
    
  1/1/1900 12:00:00 AM -> 1900 
    
  6/15/2009 1:45:30 PM -> 2009 

"yyyy" The year as a four-digit 
number. 

1/1/0001 12:00:00 AM -> 0001 

    
  1/1/0900 12:00:00 AM -> 0900 
    
  1/1/1900 12:00:00 AM -> 1900 
    
  6/15/2009 1:45:30 PM -> 2009 

"yyyyy" The year as a five-digit 
number. 

1/1/0001 12:00:00 AM -> 00001 

    
  6/15/2009 1:45:30 PM -> 02009 

"z" Hours offset from UTC, 
with no leading zeros. 

6/15/2009 1:45:30 PM -07:00 -> -7 

  
  

"zz" Hours offset from UTC, 
with a leading zero for a 
single-digit value. 

6/15/2009 1:45:30 PM -07:00 -> -07 

  
  

"zzz" Hours and minutes offset 
from UTC. 

6/15/2009 1:45:30 PM -07:00 -> -07:00 

  
  

":" The time separator. 6/15/2009 1:45:30 PM -> : (en-US) 
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  6/15/2009 1:45:30 PM -> . (it-IT) 
    
  6/15/2009 1:45:30 PM -> : (ja-JP) 

"/" The date separator. 6/15/2009 1:45:30 PM -> / (en-US) 
    
  6/15/2009 1:45:30 PM -> - (ar-DZ) 
    
  6/15/2009 1:45:30 PM -> . (tr-TR) 

"string" Literal string delimiter. 6/15/2009 1:45:30 PM ("arr:" h:m t) -> arr: 1:45 
P 

    
'string' 6/15/2009 1:45:30 PM ('arr:' h:m t) -> arr: 1:45 P 

% Defines the following 
character as a custom 
format specifier. 

6/15/2009 1:45:30 PM (%h) -> 1 

  
  

\ The escape character. 6/15/2009 1:45:30 PM (h \h) -> 1 h 

Any other 
character 

The character is copied to 
the result string 
unchanged.   
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